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Introduction

WriteLog is the best RTTY contest software available on the market today.  There are other software packages that will work for 
RTTY contesting, but none come close to the features and support offered by WriteLog.

WriteLog is not brain surgery or rocket science, but it's difficult enough that the learning curve can be quite sharp for newcomers.  
With this tutorial, it's hoped that beginners will have an easier time getting started using WriteLog for RTTY contesting.

Whether you're operating RTTY for the first time or you are an experienced RTTY operator using WriteLog for the first time, it's 
hoped that these pages will get you up and running quickly.  Before you begin using WriteLog for RTTY, go to the WriteLog help files 
and read all the pages concerning RTTY if you haven't done so already, and then come back to this tutorial.  By combining the 
resources of the Help files and this tutorial, you should have a better understanding of how RTTY is operated using WriteLog.

If you are a first time RTTY operator, I strongly suggest you first go my tutorial "Getting Started on RTTY".  Read it and get an 
understanding of how to operate RTTY.  Join the RTTY Reflector and ask questions. There's a large group of RTTY operators there 
that are more than happy to help.  The assumption, for this tutorial, will be that you already have your hardware working on RTTY.  Be 
sure you can send and receive on RTTY before trying to use WriteLog.

Using MMTTY

There are some things that need to be covered before getting started.  A recommendation is going to be made for the use of the 
MMTTY plug-in for WriteLog.  MMTTY is a stand-alone RTTY program written by Mako, JE3HTT, which uses a sound card in your 
PC to decode RTTY and to transmit RTTY in the AFSK mode.  MMTTY will also transmit FSK via a serial COM port or USB-to-
serial adapter.  MMTTY is free and only requires a sound card in your PC to run.  There is no need for any other external device other 
than cables to connect the computer to the radio (running FSK does require an external interface circuit either commercial or homebrew 
as shown here).

Jorgen, SM6SRW, wrote a plug-in program that allows the MMTTY engine "mmtty.exe" to be used with WriteLog.  This plug-in is 
available in "beta" form only, meaning that if it doesn't work with your system, it's not WriteLog's fault.  Yet, since the MMTTY plug-
in has been in use since mid 2001, it's been widely accepted and works on every Windows platform that WriteLog works on.  Some 
users experience "lock ups" or "crashes" but these cannot always be directly attributed to WriteLog or the plug-in.  For the most part, 
the MMTTY plug-in works fine.  If you experience problems, there are several users on the WriteLog Reflector that will be happy to 
work with you in getting these problems resolved.  If you do not subscribe to the WriteLog Reflector, it is recommended that you do 
so.  This "reflector" is a news group created for discussions on issues related directly to WriteLog.  It's excellent forum to find help in 
resolving problems or getting your WriteLog questions answered.

MMTTY is not the only way to use WriteLog on RTTY.  It's recommended for several reasons.  First and foremost - it's free.  
Secondly, it has an excellent decoder.  And the program is fully supported by Mako. He listens to his users and is consistently working 
to improve his program.  MMTTY is so good, I personally could not even think of operating a RTTY contest without it.

TNC Support

WriteLog also supports several external TNC's and TU's (terms used for "boxes" or "cards" that do RTTY).  WriteLog supports the 
following hardware that can be used to transmit and receive RTTY: PK-232, KAM, SCS PTC-II, KT4FY Multimodem as well as the 
HAL units DXP-38 & DSP 4100.  HAL modems that install as PCI cards inside your computer such as the PCI-3000, PCI-4000 and P-
38 are also supported. WriteLog also supports the use of RITTY by K6STI, which is DOS based software for use with certain 
SoundBlaster sound cards.  WriteLog also supports other modems through use of its "Dumb Terminal Use" mode.  And WriteLog has 
it's own RTTY program for use with a sound card called WinRTTY.

It's not the purpose of these instructions to show how to use each of these modems.  We'll concentrate on the basics of using WriteLog 
in the RTTY mode.  Since most newcomers do not already own an external TNC or TU, basic instructions will be shown on how to use 
MMTTY and the MMTTY plug-in for WriteLog.

RTTY Contest Support
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WriteLog supports every major RTTY contest.  And with the installation of the SM6SRW RTTY modules, available from the Third 
Party Downloads Page of the WriteLog website, nearly all other RTTY contests are now supported.  A "module" is simply a driver 
written for a particular contest.  SM6SRW created several modules for RTTY contests that WriteLog did not originally support. As 
much as Jorgen should be commended for giving us these modules, it should be mentioned that many of the SM6SRW modules have 
bugs, which makes WriteLog react differently than when using standard WriteLog modules. These modules were never fixed and these 
bugs continue to exist. There are several ways to work around the bugs and they are an inconvenience, but without these modules, we 
would not be able to use WriteLog for those unsupported contests. So if you operate your first RTTY contest using one of these 
SM6SRW modules, don't be discouraged by some strange occurrences associated with these modules. The standard modules provided 
by WriteLog work fine.

WriteLog presently comes with the following contests fully supported: ARRL RTTY Roundup, BARTG Sprint and Spring RTTY 
Contests, WPX WW RTTY Contest, NAQP RTTY Contest, ANARTS RTTY Contest, SARTG RTTY Contest, CQ/NRJ WW RTTY 
Contest, JARTS WW RTTY Contest, WAEDC RTTY Contest and the TARA RTTY Sprint.

By installing the SM6SRW module package you get these additional contest modules: Anatolian RTTY WW Contest, ARI 
International DX Contest, EA RTTY Contest, FMRE International RTTY Contest, Russian RTTY WW Contest, SARTG New Years 
Day Contest, SCC RTTY Championship, SPDX RTTY Contest, Ukrainian DX Contest and VOLTA RTTY WW Contest.

In addition to the above mentioned RTTY contest modules, Carsten DL1EFD has written a module for the DL-DX RTTY Contest.  
This module can be found at www.dl1efd.de/.

The RTTY Starter Road

The road to getting started using WriteLog can be long or short.  Because of all the wonderful features of WriteLog, it's possible for a 
newcomer to get sidetracked on features that are not absolutely needed, like radio control or using Super Call Check or some other 
feature that is not directly related to transmitting or receiving RTTY.

Get your hardware working first. Once you can transmit and receive RTTY using Rttyrite, then start integrating the other features that 
make WriteLog such a powerful program.

So let's get started. 

Checking for the latest WriteLog Version

If you already use WriteLog, you may skip this page and move on to Page 3.  If you are new to WriteLog, the first thing you should do 
is check to make sure you have the most up-to-date version of WriteLog installed on your PC.  Open WriteLog.  If you are opening 
WriteLog for the very first time, the opening screen looks something like this. 

This is an important screen. Before going further, it's always a good idea to check which version of WriteLog you are using.  WriteLog 
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is being updated constantly with improvements and fixes.  You should keep up with these updates and update the program on a regular 
basis.  The version shown above was 10.38D.  To check to see if you have the most current version available, go to the WriteLog 
website and check the Downloads Page. 

As you can see, I did not have the latest upgrade on my PC.  Version 10.39C was the latest upgrade at the time this page was created.  
So I downloaded WL1039CUPG.ZIP and installed the upgrade.  There are simple instructions on the Downloads Page on how to install 
the upgrade.  You can find a full revision history and what changes have been made on the Revision History page on the WriteLog 
website.

Once you know you have the latest version of WriteLog installed, click "Start a new log...".

Selecting the Contest

When you click on "Start a new log..." from the opening screen, WriteLog opens and a dialog box with a list of contest modules 
available will be shown.  (Note:  If the contest you are looking for is not shown in the list, then it may be a module that was written by 
a third party such as the SM6SRW RTTY modules or the DL-DX RTTY module by DL1EFD as mentioned on Page 1).
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We will use the "CQ World Wide RTTY Contest" as our example. Scroll down to "CQ World Wide RTTY Contest" and either double 
click on the contest name or highlight it and click "OK". 

For our example, we have opened WriteLog using the "CQ World Wide RTTY Contest" module.  

Parameter Setup

The first thing you should do is a Parameter Setup.  With Parameter Setup you tell WriteLog information which is used to score 
whatever contest module you are using.  THIS IS EXTREMELY IMPORTANT.  If you don't tell WriteLog certain parameters, it may 
not score the contest correctly and may not even score it at all.

Go to the Contest Menu and select Parameter Setup.  A window will open where you input the information required to score the contest.
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The Parameter Setup window will be different for each contest because each contest requires different information.  Some contests do 
not require any parameter information and when the Parameter Options window appears it will tell you that no parameter information is 
required.  Forgetting to input contest parameter information is the #1 source for scoring problems found during contests.  DON'T 
FORGET TO SET THE PARAMETER INFORMATION BEFORE EACH CONTEST.

Once Parameter Setup has been completed, it's time to Save your File.

Saving Your File

After you choose which contest module you want to use, save the file you have started.  Go the File menu and select Save or Save As... 
(or press the diskette icon on the toolbar).  Navigate to the location where you want to save the file.  I prefer to keep all my contest files 
in the C:\ham\contest\ folder (Note: newer WriteLog installations now install in the \Program Files\WriteLog folders.  So the path to 
the contest folder is \Program Files\WriteLog\contest\). If the dialog box opens up to the C:\ham\Programs folder (or C:\Program Files
\Writelog\Programs folder), simply navigate to the \contest folder. You may choose to save your contest files in some other location on 
your hard drive and that is OK.  Just as long as you remember where you saved your files!
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Naming Your File

You can name your file anything you want.  I personally prefer to include the name and year of the contest in the file name. For this 
example, we are using the CQ World Wide RTTY contest module and I will name my file "CQWWRTTY03" if the year is 2003.  
Others prefer to make individual folders for each contest.  It doesn't matter.  It's up to you how you want to save your logs. The 
extension .wl will automatically be added to the file name designating that this is a WriteLog log file.

Opening the RTTY Window

Before opening the RTTY Window, make sure your WriteLog window is not maximized, taking up the whole screen.  Reduce it to 
about the size shown below.  This is important and will be explained later.  You can resize it by dragging the top, bottom, sides or 
corner edges in or out.  Once the window is adjusted, go to the Window menu and select "RTTY Window". 

Arranging Your Screen

When you choose "RTTY Window" from the Window menu, a Rttyrite window will open.  As you can see, the Rttyrite window will 
probably open on top of the main WriteLog window.
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You cannot operate RTTY if the Rttyrite screen covers the main WriteLog window.  As soon as you click your mouse inside the 
Rttyrite window, the main WriteLog window will cover it up.  This happens to a lot of new users and they can't understand why their 
Rttyrite window "disappears". When you begin to copy RTTY, callsigns will come across the screen.  When you click on a callsign in 
the Rttyrite screen, the keyboard focus goes to the Entry Window in the main WriteLog screen.  Therefore, the main WriteLog window 
comes to the forefront and covers the Rttyrite screen.  This is undesirable.

Move the Rttyrite window above or below the main WriteLog window by left clicking on the blue title bar at the top of the window and 
dragging it up or down. You may need to resize it smaller.  I prefer to have the Rttyrite window below the main WriteLog window, but 
you can move it anywhere you prefer just as long as they do not overlap.  (Note:  There is a reason I prefer the Rttyrite screen lower 
than the main WriteLog window.  During RTTY contesting you will focus your eyes more on the Rttyrite screen than you will the main 
WriteLog window.  By placing it below the main WriteLog window you will not have to train your head as high to concentrate on it 
(this depends on monitor placement).  In the long run, this will cause less fatigue by not having to crane your neck looking upward.)  
When finished, your screen may look like this.  Again, it's your preference how you want to arrange the windows on your screen.  Just 
make sure they do not overlap.
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Saving Your Configuration

Once you have your two windows arranged how you want them, you need to save the configuration so that the next time WriteLog is 
opened, these windows will be in the same position and you won't have to rearrange them again. Go to the Setup menu in the main 
WriteLog window and choose the last option in the list "Save Configuration...".
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The Writelog.ini options dialog box will open. If not already populated, enter your name and address. Then check the "Rtty" check box 
and click OK. These entries are saved in the writelog.ini file and the next time you open WriteLog, the Rttyrite window will also open 
in the same location you placed it on your screen. The name and address will also be saved and entered into any Cabrillo file or 
summary sheet that you might generate after a contest.

Saving Your File (again and again)

Any time you make ANY changes to your set-up, you need to Save Configuration AND Save your file.  This is very important.  Any 
additions or changes you make will be lost next time you open WriteLog if you don't perform both steps of Save Configuration AND 
Save your file. You can easily save your file by pressing the diskette icon to the left of the main WriteLog window.

(AA5AU Opinion) - It's my opinion that you only need to see a few lines of your log.  I set up my main WriteLog window so it is only 
as high so that the diskette icon is showing.  This is so that I can easily save changes to my log.  Look at the screen shot below.  I've 
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resized the main WriteLog window so the "Save" diskette icon is the last one showing.  This gives me room in the log for about the last 
three contacts.  That's all I really need to see. By reducing the size of this main window, I've made room for other windows, as I need 
them.

Choosing your TU Type

TU stands for "Terminal Unit".  It's a general abbreviation for any modem (modulator/demodulator) that is used for RTTY.  It could be 
an external hardware device like a KAM, PK-232 or DXP-38 or it could be a software program like WinRTTY, MMTTY or RITTY.  
You choose which type of modem you are going to use in the Rttyrite window under the TU Type menu.  If this is the first time you 
have opened the Rttyrite window, the default TU Type will be shown as Dumb Terminal Unit.  If you are first starting out using RTTY, 
you will more than likely never use the Dumb Terminal Unit option.  However, this setting is important in that it can be used to get you 
out of trouble in some cases.

There can be several scenarios, that I won't go into detail about at this point, where you can get into a situation where you try to change 
from one TU Type to another and WriteLog will not let you do it for some reason or another.  A safe way to change from one type of 
TU Type to another is to choose Dumb Terminal Unit first, then choose a different TU Type after that.  I only mention it now so that if 
you do find yourself in this situation as you experiment with the program, you can get out of trouble easily.  If you receive a Rttyrite 
error message when changing from one TU to another, try closing the Rttyrite window and reopening it.  This usually clears the 
problem.  Once you have decided on a certain TU type, you won't have to change this setting again because it will be written in the 
writelog.ini file and it whenever you activate the Rttyrite window, that TU type will already be set.

As mentioned before, I am assuming that you have all your cables connected to your radio, computer, etc. and have already operated 
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RTTY and have a working RTTY hardware connection between computer and radio.  Since MMTTY has become the most popular TU 
Type used with WriteLog, it will be used as an example here.  However, you cannot use MMTTY unless you have it installed on your 
computer along with the MMTTY plug-in for WriteLog.  Both must be installed.  If you have not done that yet and you want to use 
MMTTY with WriteLog, go to the Tutorials Page and read the tutorial called "Installing and Using the MMTTY Plug-in".

WinRTTY options in place of MMTTY

As discussed, the TU Type menu option allows you to select which "TU Type" you wish to use.  If you want to use your soundboard 
for RTTY but do not elect to use the MMTTY plug-in, you can use WriteLog's own RTTY soundboard program called WinRTTY.  
The last four entries in the TU Type list are Sound Board AFSK, Sound Board FSK, Stereo Sound Board AFSK and Stereo Sound 
Board FSK.  These are all options you can choose if you elect to use WinRTTY.  In our example above, the "Stereo" options are grayed 
out.  The "Stereo" options will be grayed out if the PC used either does not have a stereo soundboard installed or the stereo sound card 
is not compatible with WriteLog for 2 Radios.  You will only be concerned with the Stereo options if you choose to run WinRTTY 
using two radios.  You can perform a Sound Board Check to test your soundboard's compatibility with WriteLog.  To find out how to 
perform the Sound Board Check on your PC click here.

The Port Menu

Before selecting your TU type, it's important to discuss the Port menu option.  If you are going to use an external TU such as a KAM, 
PK-232 or DXP-38, you must tell WriteLog which COM port this device is connected to.  Or if you are going to use one of the 
soundboard programs such as MMTTY or WinRTTY and transmit FSK via a COM port, you must tell WriteLog which COM port the 
FSK is going to be generated on.  This is all done in the Port pull-down menu in the Rttyrite screen.  (Please note that FSK and PTT are 
always keyed on the same COM port.)

Important Note - When using the MMTTY plug-in for WriteLog, the FSK port is set via the Port setting in the Rttyrite menu and not on 
the TX tab of MMTTY setup where it would normally be set if you were operating MMTTY as a stand alone program.

If you are going to be transmitting AFSK with MMTTY, WinRTTY or RITTY by K6STI,  you will not need to set a COM port unless 
you are using a COM port to provide PTT to key your radio.  If you use an interface connected to a COM port to key PTT,  you must 
set the port setting to the COM port number where the interface is connected.  If you are using MMTTY, WinRTTY or RITTY using 
AFSK and keying PTT either via VOX or through radio control, then you can leave the port setting to None.

Beginning with WriteLog version 10.58 in early 2006, a new featured called Software-generated FSK was introduced.  This feature 
allows 5-bit Baudot FSK to be generated from a USB-to-serial port adapter.  

The last options in the Rttyrite Port menu are "Software generated FSK TXD" and "Software generated FSK DTR".  If you are going to 
use a USB-to-serial port adapter to generate FSK, you must select one of these two options after you select your port number.  
Software-generated FSK acts in a similar fashion to MMTTY's EXTFSK, in that it allows 5-bit Baudot FSK to be generated on either 
the TxD or DTR line of a USB-to-serial port adapter.  It must also be noted that unlike EXTFSK, FSK generation on an LPT port is not 
possible.
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If you are using a Microham "USB Interface II", or an interface that keys FSK on DTR instead of TxD, then you need to select 
"Software generated FSK DTR".  Most FSK interfaces key FSK on TxD.  If you have a CW interface that keys CW on DTR, you can 
use this interface to key FSK with WL by using "Software generated FSK DTR".

Software-generated FSK will work with either a simple homebrew transistor FSK keying circuit or with commercial interfaces that 
offer FSK keying.  For more information on Software-generated FSK, click here.

"COMM port not available." error message

If you get this error message when you try to set a port in the Ports menu of Rttyrite, it is because the port you are trying to select is 
already in use.  It could be in use by another program that is running on your PC at the same time, but more than likely, it's because the 
port has already been assigned within WriteLog itself.  The most likely occurrence of this problem is when the port has been assigned 
in the Setup menu option Ports... in the main WriteLog window.  If you use the same COM port to generate CW and FSK, it's possible 
the port could be assigned for CW and not available for RTTY.  Go to the main WriteLog window, and select Ports... under the Setup 
pull-down menu.

When the Port Setup window opens, check to make sure the COM port you wish to use in Rttyrite is not already selected.  In the 
example below, COM 1 was already selected for CW.  Therefore it is not available for RTTY.  To de-select a COM port in this 
window, click the small circle at the bottom of the column.  This clears all ports from CW.  To deselect a COM port from the Rig 
column, just uncheck the box.  The port could have been assigned to rotor control, so check that selection also.
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Once you have cleared your COM port, you can go back to the Rttyrite window and select the appropriate COM port (if applicable).  
Also note, that FSK and PTT can be generated from the same COM port.  So the COM port you select from the Rttyrite Port menu 
could be used for both FSK and PTT at the same time.  This is permissible and desired in many cases. In order to key FSK and/or PTT 
from a COM port you need some sort of interface circuit to convert RS-232 levels from the TxD and RTS lines of the port to on/off 
keying to the FSK and PTT inputs of your radio.  Examples of simple interface circuits can be found here.

Once the COM port is set (if applicable), go ahead and select your TU type. In our example, we will choose MMTTY as our TU type.

When MMTTY is selected, the MMTTY RTTY control panel should appear. If this is the first time MMTTY is run, a dialog window 
may appear where you will need to navigate to the location of the MMTTY engine, Mmtty.exe. If the MMTTY program was installed 
in it's default location, the program Mmtty.exe will be located in the C:\Program Files\Mmtty\ subdirectory (or folder). Once you 
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choose the location in the dialog box and click OK, the MMTTY RTTY control panel will appear. If for some reason you get a Rttyrite 
error message, close Rttyrite and reopen it. It should open up to the MMTTY RTTY control panel and it should look something like 
this.

It's possible the RTTY control panel will not look like this. And it's possible the RTTY control panel will open on top of either the 
Rttyrite window or the main WriteLog window. If this happens, drag the RTTY control panel off either of the other two windows so 
they do not overlap. You can also resize this control panel and change several of its characteristics. For example, you can add the 
Profile buttons (shown above at the bottom of the panel as P1-CQ, P1-S&P, etc. The different configurations available within the 
MMTTY control panel are explained in two pictorials. "Installing & Using the MMTTY Plug-In" and "Getting Started on RTTY". It's 
highly recommended that you browse these two tutorials if you have not done so already. If you have trouble running MMTTY with 
WriteLog, pay particular attention to the MMTTY Plug-in Troubleshooting Page (Page 7 of the tutorial).

Other than the menu options on the RTTY control panel, configuration changes can be made via the TNC Setup... option under the TU 
Type menu in the Rttyrite window as shown here.
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In the Rttyrite MMTTY Settings window, you can change View Settings, Profile Settings and other Options. You can also go to 
MMTTY Setup via the "MMTty Settings..." button.  (Note:  If you are using a TU type other than MMTTY, TNC Setup will bring to a 
different screen than shown.)

Pressing the "MMTty Settings..." button will bring you to the regular MMTTY Setup window.  If you are familiar with MMTTY as a 
stand-alone program, you will recognize this window.  t's nearly exactly the same with only slight differences.  The main difference 
being the option of selecting the port assignment for FSK and/or PTT is not shown on the TX tab.  Instead, the port assignment is 
selected via the Ports menu in the Rttyrite window as previous discussed on Page 6.
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Transmitting RTTY

By now, you should be receiving RTTY using whatever type of TU you selected.  Be sure you can receive before you try to transmit. 
We will go back to receiving RTTY topics later such as callsign highlighting and call capture. Now let's try to transmit.

There are several ways to transmit RTTY with WriteLog.  During contesting, you will use pre-programmed RTTY messages and use 
the F keys on your keyboard to send these messages.  You can also type "live" from the keyboard using the ALT+K command.  In both 
these instances, the keyboard focus must be in the main WriteLog window and the cursor in the Entry window.  The third way to 
transmit is using the type-ahead buffer.  You can also transmit special buffer messages using a mouse and this will be covered on Page 
10.

Pre-programmed RTTY messages

During RTTY contesting, nearly all transmissions are done using pre-programmed message buffers.  These messages are created via 
the CW/RTTY/SSB messages... menu option under Setup in the main WriteLog window.

Here is what the CW/RTTY/SSB Memory Setup window looks like when first opened.  It will show some message buffers already 
programmed.  You will not use any of these type of buffers on RTTY.
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The message buffers for RTTY are different than those used for CW or SSB.  Special characters are used in message buffers.  These 
characters are preceded by the % sign.  For a complete list of these special characters, refer to the WriteLog help file.  Go to the Help 
menu in the main WriteLog window, select Help Topics, and select the Index tab.  Type in "RTTY Message" in the topic box to find 
out more information on setting up the RTTY messages.

I've created example message buffers for nearly every RTTY contest.  These RTTY message buffer examples can be found here.  
Select the contest from the pull-down menu to show the example for that particular contest.  Note that the buffer examples shown are 
set up without using the CT-compatible mode and the messages programmed will correspond to F2 through F11 (F1 would do 
nothing).  I would recommend not using the CT-compatible mode if you are just starting out.  CT-compatible mode is not default with 
WriteLog and must be set up in the Writelog.ini file under the [Configuration] section.  The CT-compatible mode does give you the 
ability to use F1 as a buffer and F11 becomes ALT+W (clears the QSO Entry Window).  If you are interested in using the CT-
compatible mode, see the WriteLog help file under "Message Shortcut Keys".

Not only can you program F2 through F11 as messages, you can program additional messages which will be sent by holding the "Shift" 
key and pressing an F key at the same time.  These are called "Shifted keys".  You program the Shifted keys by clicking the radio 
button next to "Shifted keys" as shown here.  Again, by default, you can program shifted F2 through F11.  If you are using CT-
compatible mode, you can program shifted F1-F10.
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There are other ways to transmit RTTY with WriteLog that will be explained on Page 10.

Important Note - If you are using AFSK and your radio is set for LSB, you need to check the LSB is really FSK... option under the 
Bands menu in the main WriteLog window. Click here for details.

Transmitting using ALT+K

With the cursor in the Entry window of the main WriteLog screen, you can transmit "live" from the keyboard using ALT+K by 
pressing the ALT key and the letter K on the keyboard at the same time. ALT+K will toggle the transmitter on and off. When ALT+K 
is pressed a window will open where you can begin typing "live" from the keyboard.

Type Ahead Buffer

The third way to transmit RTTY from WriteLog is via the Type ahead buffer window. This window is available by selecting Type 
ahead... from the File menu in the Rttyrite window.

The type ahead buffer is mainly used for non-contest RTTY contacts when making casual RTTY QSO's. It allows you to begin typing a 
message to a station you are in QSO with while the other station is transmitting to you. When you select Type ahead... from the File 
menu, the Type ahead window will open.
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When you are ready to transmit what you have typed, press the Transmit button. You don't have to be finished with your entire 
message. As the message is being sent, you continue typing in the Type Ahead window. When you are finished with your message and 
ready to end your transmission, hit the OK button, not the Receive button. When the type ahead buffer is empty, the transmitter will un-
key and go back to receive automatically when the OK button is pressed. If you hit the Receive button, the transmitter will un-key 
immediately, but the remaining contents of the buffer will be saved and you can continue on by re-activating the Type ahead window. 
If you would like to stop your transmission and clear the contents of the type ahead buffer, press cancel. Pressing the Receive button 
and then the ESC key on the keyboard does the same thing. The Add File... button allows you to send the contents of a text file.

AA5AU Opinion - Many operators would not think to use WriteLog as their everyday RTTY program. Many choose to use other 
programs they are more familiar with such as MMTTY stand-alone. However, I strongly believe that if you are serious about becoming 
a competitive RTTY contester, you should use WriteLog as your everyday RTTY program. By doing this, it allows you to become 
more intimate with the workings of WriteLog and when it comes contest-time, you will be ready to go and not have to re-learn the 
program all over again.

Before each RTTY contest, I set up WriteLog with that particular contest module. Then I use WriteLog in my everyday RTTY 
operations. This way I can become familiar with how a particular contest module may work before the contest. It has allowed me learn 
WriteLog better.

You can also log contacts that you actually make before the contest, then just before the contest, export the log data to an ADIF file and 
import the log data into your favorite logging program. However, if you decide to do this, you will have to create a new log file before 
the contest starts with no contacts logged.

On the next page we will start putting it all together so we can get the big picture of how it all works. 

RTTY Contesting

RTTY contesting is the same as CW and SSB contesting in that you make 2-way contacts with other stations, log the QSO's, score 
points and at the end come up with a total contest score.  It's also the same in that there are two ways to operate - you either run a 
frequency (CQ) or look for stations with are CQ'ing and call them (Search & Pounce - S&P).

However, RTTY contesting is unique in several ways.  First off, you don't have to decode the signal in your head.  The TU and 
computer do it all.  You basically just tune your radio onto RTTY signals and look at your computer screen to see calls and reports.  So 
in this way, RTTY contesting is much easier than CW or SSB.  And it gets even easier with WriteLog.

Callsign Highlighting

WriteLog has the ability to highlight callsigns in color as they come across the Rttyrite screen.  A callsign may highlight either Yellow 
(I like to say it's actually Gold in color), Green or Red or it's possible a callsign may not highlight at all.  Any callsign that comes across 
the screen, whether it's highlighted or not, can be clicked on (left click) with the mouse and the call will automatically be put into the 
Entry Window.  This is called populating the Call field of the Entry Window.  If a call is highlighted in color, you need only to click on 
any part of the callsign for it to populate the Entry Window.  If a callsign is not highlighted in color, you must click on the first 
character of the callsign in order to bring the full callsign to the Entry Window.

Callsigns highlighted Yellow are stations which are new multipliers.  Callsigns highlighted Green are new stations that have not been 
worked on that band but are not multipliers.  Callsigns highlighted Red are dupes (stations that have been worked before on that band).
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What makes a callsign highlight?  There are several factors involved that determine whether or not a callsign will highlight.  Any 
callsign followed by "DE" will highlight.  Callsigns not preceded by "DE" will highlight if that callsign is included in a "Super Check 
Partial" database file and this file is active for the contest you are operating.  Callsigns that are not in the database will highlight if that 
station has been previously logged during the current contest.

Super Check Partial

The Super Check Partial feature of WriteLog and callsign highlighting go hand-in-hand.  Both are functions of a database file with the .
dta extension.  A file with the .dta extension is basically just a list of callsigns but in a special format that WriteLog can read.

Super Check Partial is a feature of WriteLog that looks at characters entered into the Call field of the Entry Window and displays any 
calls that are listed in the .dta file to determine if there is a match. For example, if you enter AA5A into the Call field of the Entry 
Window, WriteLog will check the .dta file that is active to see what callsigns include AA5A and will list all of those callsigns in the 
Super Check Partial window. For more detailed information on Super Check Partial and how to use it, go Super Check Partial tutorial 
here.

WriteLog also uses the .dta file selected to highlight callsigns that scroll across the Rttyrite screen.  If a callsign comes across the 
screen that is listed in the .dta file selected, the callsign will highlight.  This is one of the most powerful tools WriteLog offers for 
RTTY contesting which other programs do not have.

Testing Callsign Highlighting

You don't have to actually receive callsigns over the air to test Callsign Highlighting.  You can type directly into the Rttyrite screen 
with callsigns and they will highlight.  In order to do this, first put the keyboard focus on the Rttyrite screen. You must do this by first 
clicking on the top title bar of the window as shown.

You cannot just click inside the Rttyrite window and start typing because clicking inside the Rttyrite window causes the keyboard focus 
to jump to the Call field of the Entry Window.  This is because that is the normal function of WriteLog, to be able to click on callsigns 
and reports and have the cursor return to the Entry Window.  Once you click on the top title bar of the Rttyrite window, you can start 
typing into the window itself.  Type a known callsign in the window and it will highlight if it's in the .dta file you have selected for 
Super Check Partial.
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As you can see by typing DE DJ7AA DJ7AA K in the Rttyrite window, I have simulated being called by Wil, DJ7AA, who is an active 
RTTY contester.  His callsign highlighted because it's in the .dta file I currently have selected.  It highlighted Yellow since there are no 
calls in my log and he would be a new multiplier had this been an actual contest.  Typing W1ZT causes his callsign to highlight as well 
because he is in the .dta file selected.  W1ABC does not highlight because the callsign is not in the database.  However, if I were to 
work and log W1ABC, then next time his callsign scrolls across the screen, it will highlight.  Typing into the Rttyrite window is an 
excellent way to simulate a contest.

Simulating a Real Contest Exchange

With the keyboard focus on the Rttyrite window (by clicking the title bar) you can simulate a real contest exchange.  In the example 
above, AA5AU calls CQ.  W1ZT answers.  When I click on the highlighted W1ZT, it automatically populates the CALL field in the 
Entry window.  It also automatically populates the RCV field with 599 and the ZN (zone) field with 5 (WriteLog looks at the call and 
determines the CQ Zone automatically using the CTY file).  I send my report (in blue) to W1ZT.  He in turn sends his report to me.  I 
click on the "M" in MA and it populates the QTH field in the Entry Window.

So in this entire contact I only had to click on his call, send my report, click on his QTH and send my confirmation message (not 
shown).  The Call field is populated with the callsign when it's clicked on.  When this happens, WriteLog automatically populates the 
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RCV field with 599 and the ZN field with 5 and leaves the cursor in the RCV field on the first "9" of 599.  This is in the rare case you 
receive a signal report other than 599.  When W1ZT sends his report, all I have to do is click on his QTH of MA and it populates the 
QTH field and the contact is complete once I send my confirmation message.  I can now log the contact by hitting the "Enter" key on 
the keyboard.

Now that W1ZT is in the log, the next time his call is entered into the Entry Window, all fields, including his QTH will be populated 
automatically. For instance, if I move to 15 meters and come across George calling CQ, when I click on his call all fields populate 
automatically including the QTH field.

Important Note - Even though WriteLog determines the zone by the callsign, it is not 100% foolproof.  Take for instance, USA 
stations not operating in their numbered call area.  Let say W1ZT was actually in California (CA).  When WriteLog populates the ZN 
field with 5, it's incorrect.  You must manually change the zone to the correct zone number 3 or click on the zone in the Rttyrite field to 
overwrite what is showing in the ZN field.  Clicking the zone in the Rttyrite will populate the ZN field with the correct zone number.  
Always check to make sure that the exchange received matches what WriteLog thinks is the correct exchange.

Editing the Log On the Fly

In the event that you need to change something in the log, the log information can be edited "on the fly" by double-clicking on the item 
that needs to be changed. You make your changes directly and when finished, hit Enter on the keyboard. This changes the log entry 
directly. It's a great feature.

Let's break down (again) what we just saw and how it relates to RTTY message buffers.  From what we saw, you could actually get 
away with only four RTTY messages regardless of whether you are CQ'ing or S&P.  You would only need a CQ message,  Exchange 
message,  Confirmation message and a Call message.  A typical contest QSO goes like this.

Station A - CQ message
Station B - Call message to Station A
Station A - Exchange message to Station B
Station B - Exchange message to Station A
Station A - Confirmation message Stations B
End of QSO. Both stations log the contact.

Beginners are more likely to S&P than to CQ.  This is perfectly fine.  If all you want to do is tune around the band for stations to work,  
that is perfectly acceptable.  But as you become more comfortable with RTTY contesting, eventually you are going to want to CQ in 
order to enjoy the feeling you get when a station or several stations call you for a contact.  WriteLog makes it easy.

Using a Mouse

There is another great feature of WriteLog, which needs to be shown now, and it relates to how you program your RTTY messages.  
There is a reason that I recommend, in my example messages, that F3 is the Exchange message and F4 is the confirmation message.  It 
relates to right clicking inside the Rttyrite window.  When you right-click your mouse in the Rttyrite window, a small window opens 
giving you some interesting options.
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The options available when you right-click your mouse inside the Rttyrite window allows you to do many things with the mouse that 
normally would require keystrokes.  If you program F3 with your Exchange message and F4 with your Confirmation message,  then 
you could send both these messages with mouse clicks.  It doesn't really matter what you program into F3 and F4, but those are the 
only F keys available when you right-click in the Rttyrite window, so it would be more beneficial if they were programmed to 
messages you use most often.  If you do strictly S&P, you may want to program F3 with your Call message and F4 with your Exchange 
message. It really doesn't matter; it's up to you.

Your other options are logging a contact, clearing the Entry Window, adding the callsign that is in the Entry Window to the Bandmap 
or Aborting Transmission. The ESC key also aborts your transmission.

Additional Buffers via the Mouse

There are additional buffer messages available that can be sent with the mouse.  Just above the Entry Window there are buttons with 
the names CALL, RCV, etc., depending on the contest module being used, that can be programmed with short messages.  When the 
button is clicked-on with the mouse, the message is sent.  The format of these messages are exactly the same as the regular 
programmed messages sent with the F keys, using the % characters such as %C for callsign, etc.

To program these buttons with messages, press and hold the SHIFT key on the keyboard and left-click the button with the mouse at the 
same time. A small window will open where you can type in the message. Hit Enter when finished and it saves the message. 
(Remember to save your file after making changes!)
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You can program these buttons for any message you wish. This enables you to use a mouse instead of the F-keys for such things as 
sending your call, sending an Exchange message, etc.

Special Accelerator Keys "Insert" and "+"

Going back to our contest QSO, regardless of whether we use the F keys, right-click the mouse in the Rttyrite field or use the buttons 
above the Entry Window, the CQ station must perform two steps when called by an S&P station.  The CQ station must enter the 
callsign in the Entry Window and send the Exchange message.  After receiving the report from the S&P station, the CQ station must 
then send the Confirmation message and log the contact.

There are two Special Accelerator Keys that can be used by the CQ'ing station, which combines each of these two steps.

The "Insert" key on the keyboard is a Special Accelerator Key. When activated, pressing INSERT captures a highlighted callsign from 
the Rttyrite window, populates the CALL field in the Entry Window and sends the Exchange message all in one step.  It's a very 
wonderful thing.

Likewise, the "+" key on the keypad to the right hand side of a standard keyboard can be used to send the contents of the Confirmation 
message and log the contact at the same time.

These Special Accelerator Keys are configured in the writelog.ini file.  In order to activate these keys you must edit the writelog.ini file 
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and add lines to the file. If you have never edited the writelog.ini file, click here for details in accessing and editing the writelog.ini file.

A line for each Special Accelerator Key needs to be added under the [Configuration] section of the writelog.ini file as shown below.

The SendCallExchangeKey=N entry allows use of the INSERT key.  The QrzFunctionKey=N entry allows use of the "+" key on the 
keypad. Where "N" is the number of the Function key, like F3 or F4) that is used for either the Exchange or Confirmation (QRZ) key.  I 
use F3 for my Exchange key and F4 for Confirmation key.  Therefore my entries are:

SendCallExchangeKey=3
QrzFunctionKey=4

It's important than the entry be made exactly as it's spelled with upper and lower case letters.  To simplify things, you can actually copy 
the two entries from this web page as they are typed above and paste them directly into your writelog.ini file anywhere under the 
[Configuration] listing.  It does not matter where in the [Configuration] listing they are place or in what order.

Which Highlighted Call gets Captured with INSERT?

Many times when you are CQ'ing in a contest, more than one station will call and there could be more than one highlighted callsign in 
the Rttyrite window.  If you have the Special Accelerator Key INSERT set in your writelog.ini file, pressing it will capture some calls 
before others.  As you know, calls can be highlighted yellow, green or red.  With yellow highlighted calls being new multipliers, they 
will be more desirable to work.  WriteLog will always pick up a yellow highlighted call before a green one.  WriteLog does not allow 
you to capture a red highlighted call with INSERT.  If more than one yellow or green highlighted call exists, WriteLog will grab the 
last call highlighted. For example if two yellow highlighted and one green highlighted call exists, when you hit the INSERT key, the 
2nd yellow highlighted call is captured and that call is brought into the Entry Window and the Exchange is sent with that callsign.

Here are examples of which calls will be captured with INSERT.
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ON4AME will be captured by INSERT because it's a new multiplier.

 

DJ7AA will be captured by INSERT because it's the second of two green highlighted calls.

 

JY9QJ will be captured by INSERT because it is the second of two yellow highlighted calls.
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K5DJ is NOT captured by INSERT because it's a dupe. Dupes are never captured by INSERT.

 

Switching Bands/Mode Manually or Radio Control

Computer control of your radio (called Radio Control in this tutorial) is not required to do RTTY contesting but it makes it easier, 
especially when changing bands.  If there is any way possible to have radio control, I would suggest you do it even if you have to spend 
some money for an interface for your radio, an extra COM port board or USB-to-serial adapter for your PC.  WriteLog is a much more 
powerful contesting program with Radio Control.

It's not the purpose of this tutorial to get the hardware connection for Radio Control working. For help with radio control hardware 
connections, refer to the WriteLog Help file or K9JY's WriteLog website. Setting up and using WriteLog with radio control will be 
shown here.

Switching Bands & Selecting the Mode Manually

If you do not have radio control you can change bands manually with ALT+F1 or ALT+F2.  ALT+F1 moves to the next lowest band 
while ALT+F2 moves to the next highest band.  You can also change bands by clicking on the frequency button located to the left of 
the Entry Window.

When click on the frequency button to the left of the Entry Window, the "Logging/Duping Frequency for the current Entry Window" 
window will open where you can select the mode and change the frequency.  You should select FSK for RTTY (even if you are using 
LSB for AFSK).  To change bands, click on the frequency of the band you have moved to, then click OK.  In our example, we have 
moved from 80 meters to 20 meters. Every QSO logged on that band will be shown as worked on 14000 kHz.  This is OK even though 
you are actually operating farther up the band.  The important thing is that any contacts logged will be logged as 20M contacts.  Or you 
could type in a specific frequency in the frequency box, it doesn't matter.
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Activating Radio Control

As mentioned before, using Radio Control gives you so many great features that using WriteLog without Radio Control makes little 
sense.  If you don't have a spare COM port to run Radio Control you can always install an add-on COM port board in your PC or use a 
USB-to-serial port adapter.  Using a USB-to-serial port adapter is probably less expensive and easier to install since you don't have to 
open your computer to install any boards.  For information on USB adapters check my USB page here.

When you connect your radio to your PC, you need to tell WriteLog which serial COM port the radio is connected to.  To do this, go to 
the Setup menu in the main WriteLog window and select the first option shown, which is Ports...

In the Port Setup window (shown below) select which COM port your radio is connected to by using the pull-down menu under "Rig 
Type" in the row of the corresponding COM port.  When you open the Port Setup screen, it will not look exactly as the example 
below.  In the example below, COM10, COM9, COM5 & COM4 are shown.  When you first open this screen, COM1, COM2, COM3 
& COM4 will be shown.  It just so happens that I have 10 COM ports in my PC and I have assigned my Kenwood radio to COM9 and 
my Icom radio to COM4.  If you have your radio connected to a COM port higher than COM4, then you must make an entry in the 
Writelog.ini file to change one of the existing COM port "slots" to the COM port number you which to use.  For more information on 
changing CommSlots, click here.

In the example below, COM10 is shown in COM slot #1, COM9 is shown in COM slot #2, COM5 is shown in COM slot #3 and 
COM4 is shown in COM slot #4.  This has nothing to do with a slot in computer.  This "slot" number just represents which row in the 
Port Setup menu the COM port is showing up in.

In order make COM10 show up in row 1, COM9 in row 2 and COM5 is row 3, I had to make the follow addition to my Writelog.ini 
file under the [Ports] section:

CommSlot1=10
CommSlot2=9
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CommSlot3=5

WriteLog will only shown 4 rows with COM ports.  But by default, WriteLog will shown COM1, 2, 3 & 4 unless you change them 
with the CommSlot entry in Writelog.ini.  

Comm PTT

The Comm PTT selection in the Port Setup screen (shown above) is very important.  Using Comm PTT is the easiest way to key your 
radio when using radio control and takes the place of an external PTT connection if you radio supports the PTT command (Icom radios 
do not support PTT via radio control but Kenwood & Yaesu radios do).  However, if you already have an external connection for PTT 
to your radio from a different COM port, you may want to change this option to NO. There have been reports of minor problems (with 
MMTTY) when both an external PTT and Comm PTT both exist.  Once you have made your selections, click OK.  As with making 
any changes within WriteLog, you need to Save your Configuration so the changes you made will remain the next time you start 
WriteLog.

"Comm port not available" Error Message

If you get the dreaded "Comm port not available" error message, then the COM port you've selected is not available.  It could be used 
by another program running on your PC or it could be that WriteLog is using the COM port for something else.  The most likely reason 
for getting this error message at this point is because the particular COM port you've selected was already selected in the Rttyrite 
window.  Go to the Rttyrite window, check the Ports menu there to make sure the port isn't already selected there.  You cannot run FSK 
or external PTT control on the same COM port as Radio Control.  Nor can you run Radio Control or an external TNC on the same port.
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If you don't get a Comm port error message,  you should have Radio Control at this time.  However, if the frequency button to the left 
of the Entry Window says "No Rig!", then WriteLog is not communicating with your radio.  You will get this message if you have 
Radio Control enabled and your radio is turned off.  If your radio is turned on and you still get this message, you need to troubleshoot 
your connection between radio and PC.  For Kenwood radios, this could mean that you need to set the COM.RATE menu option in 
your radio.  I use a Kenwood TS-870 and set menu option 56 to 4800 baud with 2 stop bits.  If you continue to have problems, the best 
place to find answers is the WriteLog Reflector.  Send an E-mail to the group with the radio type and interface type you are using and 
someone will more than likely help you out.  Never think your question is "dumb" because the only dumb question is the one you don't 
ask!

Advantages of Radio Control will be shown on starting on page 13.

Rttyrite Window 'File' Pull down Menu Options

The File menu in the Rttyrite window has five options. They are View Wide Band Decode, Font..., Type ahead buffer..., Clone, and 
Exit.  The Exit menu option closes the Rttyrite window.

View Wide Band Decode

As you can see in the example above the View Wide Band Decode menu option is grayed out. This menu option is only available when 
you have chosen the TU Type as Sound Board AFSK, Sound Board FSK, Stereo Sound Board AFSK or Stereo Sound Board FSK to 
use WriteLog's WinRTTY sound card program.  When WinRTTY is running, this option becomes available. By checking this option, 
the Rttyrite screen running WinRTTY will split. The upper half of the screen will copy "normal" and the bottom half of the screen will 
copy in a "wide band" mode. This "wide band" mode is helpful in copying fluttery signals, like signals coming over the pole.  This 
option 

Font...

The Font... menu selection allows you to select the type of font and font size that will be used in the Rttyrite window.

The font size that comes default with the Rttyrite screen is too small in my opinion.  I found that increasing the size and using Bold 
style fonts helps ease eyestrain.  I personally prefer the Courier New font size 16 Bold.  It's your choice.  Whatever looks good and 
works well for you.
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The Type Ahead Buffer

WriteLog can be used for everyday RTTY operation.  To facilitate its use as an everyday RTTY program, it has a Type Ahead Buffer.  
The Type Ahead Buffer was explained on Page 8.

The Clone (Receive only) Option

The Clone (Receive only) option is one of the greatest additions to WriteLog ever.  It was added in early 2004.  The Clone option 
allows you to have multiple Rttyrite windows receiving the same receive audio signal as the "main" Rttyrite window.  This allows you 
to run multiple decoders on the same signal in a "dual" or more receive configuration.  The advantages of using more than one 
demodulator on a single RTTY signal is tremendous.  When the Clone option is clicked on, a new Rttyrite window will appear.  The 
first time you open a new Rttyrite window using the Clone option, the TU type is defaulted to "Dumb Terminal Unit" but can be 
changed to be used with any TU Type available in the TU type pull-down menu.

In order for the Clone feature to work, you must route receive audio to each TU type that you want to use.  This can be done by simply 
paralleling the audio to the audio input of each device, whether it be an external TU or sound card.  No special transformer is needed.  
In most cases, as I do, you can simply twist & solder the wires together in parellel.

For simplicity sakes, imagine two Rttyrite windows using two separate TU types (or demodulators) and receiving the same RTTY 
signal.  There will be many times when one demodulator will receive perfect print and the other demodulator will not.  By using two 
demodulators, you have increased the chances of receiving the information being sent from the far-end correctly.  Presently, I use the 
MMTTY Plug-in for WriteLog as my "main" Rttyrite TU Type and use a HAL DXP-38 in a "cloned" Rttyrite window for "receive 
only".  Under most conditions, MMTTY will receive better than the HAL.  But under varying HF conditions, many times the DXP-38 
will receive correctly when MMTTY does not.  Running more than one demodulator on the same signal is so advantageous in receiving 
RTTY, I can't imagine ever RTTY contesting without it.

There are some rules which apply to cloned Rttyrite windows.  First & most important, it's a "receive only" window.  You cannot 
transmit from this window by right-clicking and sending F3 or F4 as you can in the "main" Rttyrite window.  However, you can click 
on highlighted callsigns in a cloned window and they will populate the CALL field of the WriteLog's Entry Window.  Likewise, you 
can click on report information such as serial numbers, etc.

The implications of the Clone feature are far-reaching.  Experimentation with this option has shown that you can even run multiple 
Rttyrite windows using MMTTY by placing the MMTTY engine in a separate folder on your hard drive and referencing this folder for 
the new cloned Rttyrite window.  And even better yet, Windows XP allows the sound card to be accessed by more than one application 
at a time.  If you are running Windows XP, you can actually open MMTTY in a cloned Rttyrite window using the same MMTTY 
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engine as the "main" window.  I have found that using MMTTY in the main Rttyrite window and an external TU, such as my HAL 
DXP-38, in a cloned Rttyrite window works extremely well.  If you are serious about RTTY contesting, you should implement a cloned 
Rttyrite window using a 2nd TU type.

The Rttyrite Edit Menu

The Edit Menu has only one option and that is Copy. The Copy menu option allows you to copy the contents of the Rttyrite window.  It 
can then be pasted into a text editor such as Notepad for saving.

The Port Menu

This menu was mentioned earlier in the tutorial.  The Port menu is where you set the Port number for such things as TNC, FSK and/or 
PTT.  For example, if you are using an external TNC connected to a COM port, you tell WriteLog which COM port the device is 
connected to with the Port menu in the Rttyrite window.  If you are using a Soundcard program such as WinRTTY or MMTTY you use 
the Port menu to tell WriteLog which COM port you have your FSK (and/or PTT) interface connected.  FSK and PTT are always 
derived from the same COM port if using an external interface - either homebrew or commercial (such as a RigBlaster).  Or it's 
possible to run AFSK and use the port setting just for your PTT interface if you are using such a device.

If you are using a RigBlaster or RigBlaster Plus to generate FSK or PTT or both FSK and PTT, then you set the port to the COM port 
number you have the RigBlaster connected to.  And if you are using AFSK for RTTY and using Radio Control for PTT, you would set 
the port to none.

The Mode Menu

The Mode menu allows you to choose which mode to run in the Rttyrite window.  For standard RTTY, choose the first option 45 baud, 
which is 60 wpm.  The options BPSK, QPSK USB, QPSK LSB and CW will be grayed-out unless you have the one of WriteLog's 
"Sound Board" options selected in the TU type menu.

FSK-Norm! and FSK-Rev! Menus

The FSK-Norm! and FSK-Rev! menus are not really menus. They are options in themselves. Clicking on the FSK-Norm! menu option 
will cause both the transmit and receive RTTY characters to be right side up. Clicking on FSK-Rev! causes WriteLog to command 
whatever TU type you have to transmit and receive RTTY in reverse. This may be helpful in some cases in RTTY contesting.  If 
someone calls you and his or her signal is inverted, you will need to click on FSK-Rev! in order to copy them.  However, you must 
click FSK-Norm! when you transmit back to them since more than likely they were copying you OK in the first place.  When you click 
on FSK-Rev!, the Rttyrite screen turns to a gray background to remind you that you are "reversed".

If you are using MMTTY with WriteLog, you only need to press the REV button on the MMTTY RTTY Control Panel in order to 
copy stations sending in reverse. This does NOT change your transmit polarity and therefore may be an easier way to copy stations in 
reverse and not invert your transmit as well.

Another easy method of receiving RTTY stations sending in reverse is to click FSK-Rev! in a cloned Rttyrite window and copy the 
signal there while using the "main" Rttyrite window to transmit back to the station right-side-up.

AA5AU Opinion - If someone sends to you reversed, you should tell them they are inverted so they know.  In most cases, the operator 
on the other end knows exactly what he or she has done wrong and will correct it immediately.  It's courtesy to let someone know they 
are transmitting up-side-down.  However, in very high rate contests when running a pile-up, you probably shouldn't risk slowing down 
your rate and losing your pile-up to help someone out unless you want to.  It's a judgment call on your part.

The Help Menu

The Help menu allows you access to the help files that apply to the Rttyrite window. It's suggested you browse through these help files.

Bells & Whistles with Radio Control

As previously mentioned, Radio Control gives you many nice features when used with WriteLog.  Some may consider these "Bells & 
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Whistles".  I actually think of them as standard necessary features for RTTY contesting.

Direct Frequency Change from the Entry Window

One great feature of WriteLog is the ability to change frequency on your radio's VFO directly from the Entry Window.  To do this, all 
you have to do is type the frequency (in kHz) directly into the CALL field of the Entry Window; hit Enter on your keyboard and the 
radio will go to the frequency you have entered. It's a fast & efficient way to QSY directly to a frequency on the band you are on or 
even another band.

Type the frequency in kHz in the Call field and hit Enter.

Your VFO will automatically go the frequency entered as shown on the frequency button.

The Band Map

The Band Map is one of the most important features you can use with WriteLog when you have Radio Control.  The Band Map can be 
used with or without the use of a Packetcluster connection.  For single ops, use of the Packetcluster is forbidden in many contests yet it 
does not lower the importance of the Band Map.  The Band Map window is activated from the "Window" menu in the main WriteLog 
screen and this is what it looks like.
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The Band Map is basically a vertical radio dial.  It's set vertically so the callsigns "mapped" will show up horizontally and can be easily 
identified.  As you turn the VFO knob on your radio, you will see the dial move up or down depending on which way the VFO is 
adjusted.  The red pointer represents the frequency the radio is presently on.

If you were connected to a Packetcluster, WriteLog reads the callsign and frequency of an incoming packet spot and places the callsign 
on the appropriate frequency in the Bandmap in a color that will designate whether the callsign represents a station that is a new 
multiplier, new station or dupe.  By default, a call in yellow represents a new multiplier, light blue represents a new station and dark 
blue represents a dupe.  These colors can be changed but I've found the default colors to be fine.   More on Packetcluster use with the 
Band Map later.

Even when you are not connected to a Packetcluster, the Band Map is a powerful tool.  You can map stations you work or hear onto the 
Band Map.  This is especially useful in the Search & Pounce mode of operation.  When you log a station, it is mapped automatically to 
the Band Map on the frequency worked.  So as you move up or down the band working stations, all stations worked become mapped so 
that if you make another pass through the band you can quickly skip over stations you've already worked and look in between 
previously worked stations for new stations.  It's a great time-saving feature.

The Band Map window size is adjustable and has many options that will be covered later.  To the right (above) is an example of what 
the Band Map might look like after a pass through the band.  The stations in dark blue are stations that were worked and logged or 
stations that were dupes and entered into the Band Map manually.  P3A is a new multiplier (in yellow) that was passed over perhaps 
because the pileup was too big so the call was mapped manually in case the operator wanted to go back to him later.  DJ5TK was not 
worked, not a new multiplier and placed on the Band Map manually.

The amount of time a station remains showing on the Band Map is determined by the "DefaultTimeoutSeconds" entry in the 
[BandMap] section of Writelog.ini file.  The actual default entry is:
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DefaultTimeoutSeconds=1200

This allows the call to remain on the Band Map for 1200 seconds or 20 minutes.  This is usually a good amount of time to leave a 
station mapped but you can change the amount of time to anything you wish.

The Band Map window size is adjustable and has many options that will be covered later.  Above right is an example of what the Band 
Map might look like after a pass through the band.  The stations in dark blue are stations that were worked and logged or stations that 
were dupes and entered into the Band Map manually.  P3A is a new multiplier (in yellow) that was passed over perhaps because the 
pileup was too big so the call was mapped manually in case the operator wanted to go back to him later.  DJ5TK was not worked, not a 
new multiplier and placed on the Band Map manually.

Eventually as you move up the band you may want to go back and try to break the pileup on P3A again.  To get back to the P3A 
frequency all you have to do is double-click on the callsign in the Band Map with the mouse and the radio VFO will be brought back to 
P3A's frequency automatically. Sweet!

Mapping Stations Manually

An important part of using the Band Map effectively is mapping stations to the Band Map manually.  There are several ways to do 
this.  In order to map a station to the Band Map, the callsign must be in the Entry Window.

The simplest way to manually place a callsign on the Band Map manually is to set up to use the "MapCallOnSpace" option by placing 
the following line in the Writelog.ini file under the [Entry] Section:

MapCallOnSpace=1

When MapCallOnSpace is activated, a callsign in the CALL field of the Entry Window will automatically be placed on the Band Map 
when you hit the space bar.

Another way to map a call to the Band Map is to right-click the mouse inside the Entry Window.  Another window will pop up which 
gives you several options, one of which is "Add to Band Map".  Clicking on "Add to Band Map" puts the callsign that populates the 
Entry Window onto the Band Map.
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Likewise, right clicking inside the Rttyrite window produces another pop-up window where "Add to Band Map" can be selected.

You can map stations to the Band Map using the File menu option "Add Station..." from the Bandmap window, but I've never used this 
option.  It seems too time consuming.

Another Easy Way to Map to the Band Map - %B

%B when used in a message buffer will map a station to the Band Map.  Remember those special message buffer buttons located just 
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above the Entry Window shown on Page 10?  The "Call" button just above the callsign field is an excellent place to program a special 
%B buffer.  When a buffer is activated that contains %B, the call in the Entry Window is placed in the Bandmap automatically.  If you 
have a buffer containing only %B, the transmitter is not keyed but the call is still put in the Band Map.  Since the addition of 
"MapCallOnSpace " in 2004, I no longer have an F-key buffer message containing only %B.  However, I still program the "CALL" 
button in the Entry Window with %B.

The "CALL" buffer button just above the callsign field is kind of in a bad spot, which makes it perfect for %B.  Many times when the 
keyboard focus is taken away from the Entry Window, you have to click your mouse back into the Entry Window to return the cursor 
there.  And a lot of times when you click into Entry Window you will invariably, accidentally click the "Call" button.  If you have 
nothing programmed into the "CALL" button, then nothing happens.  But if you have a regular message-type buffer set up such as %R 
%C DE AA5AU AA5AU K%E, then that message is transmitted.  This, of course, is undesirable.  However, if you have only %B 
programmed into that special buffer button, clicking the button does only one thing - map the call in the Entry Window onto the Band 
Map.  I use %B in the Call button buffer in each and every contest except the NA Sprint (the Bandmap is useless in the NA Sprint 
because of the QSY rule).

Remember, to program one of the button message buffers, hold down the Shift key and left-click the button.

Most of the time you will want to manually map a callsign when you've come across a dupe while in S&P contesting mode and want to 
put the call on the Band Map so that next time you come onto that frequency you will already know who's there and you don't have to 
stop to find out who it is.

You should practice mapping stations to the Band Map manually with any of the available methods.  Mastering callsign mapping helps 
you move up or down the band quickly when S&P.

You will want to use the Band Map in every contest, so you should organize your screen to show the main WriteLog window, the 
Rttyrite window and the Band Map window, then Save your Configuration so they start up automatically in the same location the next 
time you start WriteLog.  If you use the MMTTY plug-in, you will need room for the RTTY Control panel as well.  Click here for an 
example of how you might arrange your screen to show all these windows.  This is just a basic screen layout.  Another example will be 
shown later after adding other windows. Arrange your screen the way you want it, then go to the Setup menu in the main WriteLog 
window and do a Save Configuration. Check both the Band Map and RTTY check boxes.
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Using the Band Map with a Packetcluster

Contesting with a Packetcluster is a lot of fun with WriteLog.  By using the Band Map in conjunction with the Packet Spots window, 
you can point & click to new stations as they are spotted.  Double-click on a callsign in either the Packet Spots window or Band Map 
and your radio is instantly placed on the spotted station's frequency.  It's almost too easy.

Establishing a Packetcluster connection will not be covered here.  The WriteLog Help files and K9JY WriteLog website are better 
suited for that.  After you have established a Packetcluster connection with the Packet Window, you will need to open both the Band 
Map and Packet Spots Window (do not confuse the Packet Spots window with the Packet Window - they are different).

The Packet Spots Window

The Packet Spots Window is only used when you have a Packetcluster connection.  Incoming packet spots are shown in this window 
and the spots are placed onto the Band Map as well.  Double clicking the mouse on a spot in the Packet Spots window moves the radio 
to the frequency of the spot.  (You must first have the Packet Window open for the Packet Spots window to work.)

The Packet Spots window is opened from the Window menu in the main WriteLog screen.
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The Packet Spots window can be resized to fit into your screen set-up and contains several important options.  One of the most 
important options is the "In-band Only" option. Some discussion is required here to clarify what "In-band" means.  It actually means 
"In-sub-band".  WriteLog has pre-set mode sub-bands by default.  These default sub-bands work fine for SSB and CW but RTTY is a 
different story.

Ideally, when running a RTTY contest, it's desired to have only RTTY spots show up in the Packet Spots window.  Activating “In-band 
Only” does this.  But because WriteLog has no way of telling if a spot coming in is a RTTY spot or not, it uses sub-bands to determine 
if the spot is a good spot for the contest.  This is a difficult subject to explain and may be even more difficult to understand.  Detailed 
discussion is required.

Let's start out by looking at the Packet Spots windows shown below. They are actually the same window before and after "In-band 
Only" is activated.  (Note:  The Packet Spots window changed in 2004 with the addition of a 4th check box for Azimuth Sort not 
shown here.  Also, beam headings are now shown in the Packet Spots window to the right of the spots.  For the correct azimuth to 
show, you will need to set your latitude & longitude within WriteLog.  This is explained on Page 16.)

     

WriteLog knows what mode you are operating are operating.  Since you are operating a RTTY contest, WriteLog looks at the sub-band 
for RTTY to determine if the spot is RTTY spot. In the above example, all the spots in red are outside the default RTTY sub-bands. 
The one spot shown in green is supposed to be a good RTTY spot.  However, this is another problem.  Because RTTY sub-bands share 
with both CW and SSB sub-bands, it's nearly impossible to tell if the spot is good for RTTY or not, especially on 40 meters.  In our 
example, EA6YW is the only station listed that could possibly be a RTTY spot.
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Unfortunately it's not a RTTY spot.  It was actually an SSB spot.  RTTY contacts can be made on 7098.0 kHz, but so can SSB (and 
CW) contacts in many parts of the world.  At least by invoking "In-band Only" we have eliminated spots that we know are not RTTY.  
Let's look at another example.

Here we have several stations spotted which could possibly be RTTY spots because they fall within the default RTTY sub-bands 
created by WriteLog.  But obviously something is wrong because only 8J1RF is a RTTY spot.  EA5HE is a SSB spot and the others are 
CW spots.

So how are you going to determine what's RTTY, what's SSB and what's CW?  You do that by editing the default sub-bands to show 
typical RTTY sub-bands instead of legal RTTY sub-bands.

Editing the RTTY sub-bands

Before going into a lot of detail on editing the sub-bands, it should be known that all this can be avoided by using a program called 
DXTelnet (and there may be other programs that do this as well) in conjunction with WriteLog.  DXTelnet has the ability to filter spots 
better than WriteLog and to send only RTTY spots to WriteLog.  I use DXTelnet exclusively with WriteLog and highly recommend it.  
For more information on using DXTelnet with WriteLog on a single computer click see the WA9ALS DX Telnet Page on John's 
website.  Instructions on setting up DXTelnet with WriteLog over a LAN are shown in another tutorial here.  Check the Tutorial Page.

By default, the RTTY sub-bands are set to legal RTTY frequencies.  For example, on 20 meters, the legal RTTY sub-band for most of 
the world is from 14000 to 14150 khz and that is how the default sub-band for RTTY on 20 meters is set.  However, most RTTY 
contest contacts are made from 14075-14120 khz on 20 meters (sometimes above and below these frequency in major contests like the 
ARRL RTTY Roundup, CQ WW RTTY & CQ WPX RTTY).  So in order to better "filter" spots that show up in the Packet Spots 
window when the "In-band Only" option is activated you must edit the RTTY sub-bands.  How do you that?

There is a program called EditBands.exe that comes with WriteLog.  You run this program to modify the RTTY sub-bands.  You can 
run the program by going to the Windows Start menu, to Programs and then to the WriteLog group as shown.
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Close WriteLog if you have it open. Open Edit sub-bands. Click the + sign to show the current Digital (RTTY) sub-bands.  It will look 
like this.

     

The Edit sub-bands program has many options and this can be confusing.  For USA stations, the sub-bands are broken down into three 
separate license classes - Extra, Advanced and General.  For setting the RTTY sub-band, use the Extra class file regardless of whether 
or not you are in the USA.  You'll see this option come up later.

As you can see, the default RTTY (Digital) sub-bands encompass a large part of the CW sub-band on some bands and part of the SSB 
sub-band on other bands. So to better filter RTTY spots going to the Packet Spots window, we are going to modify these sub-bands. 
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Let's start with the 80 meter band showing at 3525 to 3650 khz. RTTY is normally found between 3570 and 3625 khz during contests 
so it's suggested the 80 meter RTTY sub-band be changed to 3570 to 3625. Even though Japanese RTTY stations operate down below 
3525, it's suggested to use 3570 khz as the lower end of the RTTY sub-band for 80 meters. If not, it's likely many CW spots will show 
up in your Packet Spots window and on the Band Map looking like RTTY stations when they are not.

Select the 80 meter sub-band by clicking on it once. The lower and upper limits of the sub-band will populate the boxes as shown. 
Change 3525 to 3570, then tab over and change 3650 to 3625, then click the Modify button.

     

We will modify each of the bands except 40 meters. We will leave 40 meters as is because the whole band from 7025 to 7100 kHz is 
used during many RTTY contests. Highlight "14000 to 14100" and place it into the upper and lower range boxes, change 14000 to 
14075, tab over to 14150 and change it to 14120. Do the same for 15 but changing the lower end of the range to 21075. You can leave 
the upper limit at 21125 if you wish. Change 10 meters to 28075 to 28150. When you have finished modifying your limits, the screen 
should look like this.
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After you have modified all the frequency ranges the way you want them, click the Save button. Another window will open. Regardless 
of whether or not you are in the USA, go ahead and highlight Extra and click OK.

A dialog box will open asking if you want to replace the existing file. Choose Yes.

http://rttycontesting.com/writelog/rttystarter/starter_page_all.html (43 of 52)12/8/2007 6:14:41 AM



WriteLog RTTY Starter by Don Hil

Back to the edit sub-bands window, you will now want to set the file that will be used for the Bandmap. Click on the "Set Bandmap 
file". If another window opens asking you to select which file to use for the Bandmap, choose Extra. This completes editing of the 
RTTY sub-bands.

Now, packet spots within the ranges you have set will show up colored green in the Packet Spots window the next time you start 
WriteLog, connect to a Packetcluster etc. All other spots will show in red. Also, only spots in the frequency ranges you set will be 
shown when you activate the "In-band Only" option. So it's suggested that you use the "In-band Only" option if you do not use 
DXTelnet.

As mentioned previously, spots on 40 meters will always be a problem because CW, SSB and RTTY are all operated in the 7025-7100 
kHz range. And it's possible a RTTY station could operate outside the range you have set, but it's rare. By reducing the sub-band, 
getting rid of unwanted spots far outweighs any spot you might miss because it falls outside the range you've set. Just don't set your 
range too narrow. The suggested ranges should work fine in nearly all RTTY contests.

With the Band Map and Packet Spots window activated, you can now double click on a callsign in either window and your radio's VFO 
will instantly go to the spotted frequency. It's a great feature.

Undocking Windows

Although not previously mentioned, undocking different WriteLog windows from the main WriteLog window needs to be explained.  
The Rttyrite window, Band Map, Packet window and MMTTY RTTY Control Panel (if used) cannot be part of the main WriteLog 
window.  They will always be in their own window.  However, all other windows can be part of the main WriteLog window and this 
may or may not be desirable.  Personally, I prefer all my WriteLog windows to be undocked from the main WriteLog window.  In the 
Window menu of the main WriteLog window, all window options below the horizontal line starting with "QSO Entry Window" can be 
docked or undocked from the main WriteLog window.

Sometimes when you activate one of these windows, it will be docked to the main WriteLog window and totally mess up how you have 
your main window configured.  For example, below is the main window before opening the Packet Spots window.

This is what the window could look like after opening the Packet Spots window (or any other window that can be docked).  Ouch, what 
happened to my log?

http://rttycontesting.com/writelog/rttystarter/starter_page_all.html (44 of 52)12/8/2007 6:14:41 AM



WriteLog RTTY Starter by Don Hil

Don't despair.  The Packet Spots window can be undocked from the main WriteLog window and the main window will return to its 
normal state.  To undock a window from the main window, move your cursor along the inside edge of the window you want to undock 
until you see this the cursor change to a small rectangle with a plus sign (+) just above it to the left.  When you get this cursor, hold 
down the Shift key on the keyboard and drag the window you are trying to undock away from the main WriteLog window with the 
mouse.  This will undock it.  To dock an undocked window, just drag it with the mouse into the main WriteLog window and it will 
dock, but prepared to do some window rearrangement.  Once you get the hang of it, it's not too bad.

Band Map Show Band Edges Option

There are two more Band Map options not shown on the previous page that need to be covered.  Go back to the Band Map File menu.  
There are two options, which are of some importance. The first one is Show Band Edges option.

When activated, a solid colored line will show on the Bandmap showing the mode subbands as shown below on the left.  From the 
Bandmap Colors chart (center) we see that the wide green line is for CW and the red line is for Digital (RTTY). And we can see that 
our RTTY subband begins at 14075 where we set it on the previous page. Unless you are really worried about band edges, this option 
can remain turned off (unchecked).
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You can change the default colors of the Band Map with the Bandmap Colors option in the window shown above but the default colors 
work fine.  I personally prefer dupes to show up on the Band Map in Red.  So I have changed the dark blue Dupe color to Red.  To 
change colors, select "Select Colors" from the File menu on the Band Map, then single click the color with the mouse.

Band Map Restrict clicks to legal bands Option

The other item that is of importance in the Band Map File menu is the Restrict clicks to legal bands option. This option should be 
unchecked and not used. Remember, we modified the default RTTY sub-bands on the previous page to better filter Packetcluster spots. 
Even so, it's possible a station will be spotted that is outside the RTTY sub-band and the spot could show up on the Band Map (it will 
not show up in the Packet Spots window if it's outside the modified RTTY sub-bands and the "In-band Only" option is activated). If 
you have the Restrict clicks to legal bands option checked, you would be unable to click on a spotted call outside the sub-band.

Other Windows

There are other windows that may help to have showing on the screen during a contest.  For every window that is added to the screen, 
the screen will need to be re-arranged. Eventually a "standard" screen setup will be established that the user will be comfortable with.  
Even after years of using WriteLog I find myself constantly re-arranging the screen trying to make things more efficient.  Over the 
years I've found that there are certain windows I want on the screen and some I don't.  The basic screen layout for AA5AU besides the 
main WriteLog window, shows the Rttyrite window, Band Map, MMTTY RTTY Control Panel, the Super Check Partial, the Check 
Call window, the Band Summary window and the Beam Headings window.  For contests where the Packetcluster is used, I also include 
the Packet window and Packet Spots window.  However, in those contests where packet is used, the Packet window can remain 
minimized or arranged so that only the last couple of spots are shown.  The main function of the Packet window is to pass packet spots 
to the Packet Spots window and to the Band Map.  If you don't filter spots by using a program like DXTelnet or by filter spots directly 
from the packet cluster itself, all packet spots will show up in the Packet window.  In this case, it should be minimized.

The Check Call Window

The Check Call window is an interesting window and it gives you information about callsigns and multipliers previously worked in the 
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contest.  It's not absolutely necessary for beginners but as one gains experience and moves up into more than just casual contesting, the 
Check Call window can be a valuable tool, especially in contests with band multipliers.  (The Check Call window was changed slightly 
in late 2003 with additional information.  Refer to the WriteLog help file on the Check Call window).  In the screenshot below the 
Check Window is shown below the main WriteLog window and spread out.  It's only shown this way for this pictorial.  In most cases it 
doesn't need to be spread out and can be placed anywhere on the screen.  Toward the end of this page is a link to a screenshot that 
shows how the window might be sized and where it might be placed for more efficient screen space.  If you have a large monitor and 
have room to show the complete Check Call window, by all means show the entire window.

The Check Call window tells you if you have worked a station before and if so, which band.  It also tells you information about the 
exchange information that was received from this station.  In the example above, W1ZT was worked on both 80 and 15 meters 
previously in the contest.  He was my 1st and 4th contacts in the contest and the times are given as well.  The OK next to 20M means 
the multiplier for this particular contest was previously worked on 20 meters.  It also tells me that I need this multiplier or multipliers 
on both 10 and 40 meters (the new Check Call window actually says "Need Multiplier" next to the band where the multiplier is 
needed).  So if it were late in the contest, I may try to move W1ZT to either or both of these bands to get the multiplier.  In this 
particular contest, W1ZT would represent two multipliers on those bands - Zone and QTH.

For all practical purposes, the screen can be reduced to show only vital information like this.

The Beam Headings Window

The Beam Headings window is handy to have available to know where to turn your antenna.  It's got lots of information, which may or 
may not be valuable during a contest.  The screen can be adjusted to show all the information or just part of the information.  Before 
you can use the Beam Headings window, you must set up the Beam Headings parameters in the Setup menu option Great Circle.  
(Note:  You should set up the Great Circle information regardless of whether or not you will use the Beam Heading window because 
beam headings are now shown in the Packet Spots window as mentioned on Page 14.)
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In the GreatCir Control Properties window, input your Latitude and Longitude.  If either of these is South or East then the value needs 
to be a negative number, put a minus sign in front of the number.  (The example above is for my QTH is Louisiana at 30 degrees North 
and 90 degrees West.)  You also have the option of changing the Layout, Colors and Fonts used in the Beam Headings window.  I 
prefer a smaller font, as I'll show later.  The Layout can actually be changed easier within the Beam Headings window itself so it's 
recommended you not try to configure it from the GreatCir Control Properties window unless you want.

After you have set the Latitude and Longitude of your QTH, click OK, then make sure you Save your Configuration so the changes 
will become permanent in your Writelog.ini file. Go to the Windows menu in the main WriteLog window and select Beam Headings.  
The Beam Headings window will open.

When you first open the Beam Headings window, if there is no call in the Entry Window, no information will be displayed as shown 
below on the left. When you enter a call in the Entry Window, WriteLog calculates the Beam Headings, Sunrise and Sunset 
information and displays it in the window as shown below on the right.

     

The information shown in the Beam Headings window is nice.  However, it's a lot of information that may or may not be needed.  In 
some cases, you may only want certain information shown like "Direction" and "LP Direction" (Long Path Direction).  How do you do 
that?

You can change the layout of the Beam Heading window by changing the order of the listed items.  In the example above, if you 
wanted to see only "Direction" and "LP Direction", you would need to move "LP Direction" up the list until it is directly under 
"Direction", then resize the window.  To move an item up the list, click on the item once and it will move up one line.  When you have 
the items listed the way you want them, you can then reduce the size the window if you are trying to conserve real estate on your 
screen.  You can reduce the window in the normal way by placing the cursor on the edges and dragging the edges in or out.  You can 
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also reduce the size of the Font so that you can reduce the size of the window even further without cutting off the information.  You 
change the Font back in the Great Circle menu option under Setup.  After changing the order of the list and the font, the screen could 
look like this if you wanted to show only Direction and LP Direction.

In the example above "LP Direction" was moved up below "Direction", the Font was change to 8 instead of the default value of 9 and 
the window resized to conserve screen real estate.

The Band Summary Window

The Band Summary window shows a running total of your QSO's, Points, Multipliers and total Score.

I always like to know what my score is as I'm moving along in a contest.  Another advantage of showing the Band Summary window is 
in the case where you forget to do a 

Other Windows

There are several other windows you could put on the screen if you wish.  For the beginner, the other windows won't really do anything 
for you.  One interesting window is the Rates window.  It shows what your QSO rates are for certain periods of time.  Most of the other 
windows pertain to a multi-operator setup with two or more PC's on a network.

Editing the Log

One of the most important things to learn is how to edit the log. In the event that you log a QSO with the wrong information, you can 
edit the log "on the fly" by double-clicking the item directly in the log window which needs editing. You can edit any of the fields. 
After you have edited the item, hit Enter on the keyboard to put the cursor back into the Entry Window.

Screen Real Estate

Screen real estate is at a premium with WriteLog when more windows are opened. Some users employ a 2nd monitor, which is great, 
but it requires adding a 2nd video card in your PC and will not work with Windows 95. Most important windows can fit comfortably 
on one screen. You can arrange the screen any way you wish and in a way you are comfortable with. Even after using WriteLog for 
several years, I still look for ways to improve my screen layout. Click here for an example of how the screen could be laid out to 
include the main WriteLog window plus the Rttyrite, Band Map, Super Check Partial, Check Call, Band Summary and Beam Heading 
windows.

Personally I've found that placing the Band Map on the side of the screen where the radio is located works better. This way as you 
move your eyes from the screen to the radio and back, you must pass over the Band Map screen. For contests where packet spots are 
permitted, this allows you to notice new stations popping up on the Band Map easier. It’s just a suggestion. There are probably a 
million ways you could configure your screen.
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The End

This comes to the conclusion to the WriteLog RTTY Starter tutorial.  Of all the tutorials I've written for web pages in the past, this has 
been by far the hardest.  By not knowing what information is most important to the new user, it was a difficult project.  Perhaps I went 
into more detail that I needed, but felt it was important to touch on the subjects I did.  I hope this tutorial has helped you get going on 
RTTY with WriteLog.  From the information I've presented, you should have a better understanding of how WriteLog works in the 
RTTY mode and what's important to you in how you run the program.

On the next page is a discussion on RTTY Etiquette.  It's a personal opinion and observation about what is proper when RTTY 
contesting and what is not proper.  I'd appreciate it if you read it and consider the views expressed.

RTTY Contesting Etiquette

These are my own personal comments concerning RTTY Contesting Etiquette. I believe that many of these ideas are supported by a 
majority of RTTY contesters. However, some will disagree with some of the comments I make here and that's OK.

There are some things you should take into consideration when RTTY Contesting. RTTY has always been a "gentleperson's mode". 
Still today, you see people taking the time to help others during a RTTY contest, something you are unlikely to see in CW or SSB 
contesting. I doubt that many of the poor operating practices found during RTTY contesting are deliberate. No one wants to have a 
distorted signal or to spread interference across the whole RTTY sub-band. No one wants to call other stations off frequency. And 
rarely will you come across someone deliberately trying to QRM another station. I'm not saying it doesn't happen, but it's rare.

The problems, for the most part, are caused by a lack of experience to new RTTY contesters. Many of these problems can be overcome 
with education. It's hoped the information provided here will help the new RTTY contest operator do the right thing.

Put Out a Clean RF Signal

There is nothing worse, or nothing that will give you a bad name quicker, than transmitting a poor quality signal. In every RTTY 
contest, there is always someone who is spreading QRM across the band by having an overdriven AFSK signal or some other type of 
RF problem. Your #1 priority before you transmit is to make sure your signal is clean. This should be checked out well before you start 
a contest. Either monitor your signal with another receiver or have someone check it while you are on the air. Listening to your signal 
with your transceiver's "Monitor" is not good enough. And if your signal sounds poor in your radios "Monitor", it's surely to sound 
poor going out over the air. If someone says you are transmitting spurs across the band, you might want to check your setup. People 
normally will not make these comments unless they see a definite problem.

That is not to say that someone could be mistaken when making these comments. If someone is hearing spurs or interference in their 
receiver, it could be caused by a transmit signal overloading the front end of their receiver. This is especially true when using a Noise 
Blanker. Unless your transceiver has an excellent Noise Blanker, you may want to consider never using it when RTTY contesting. 
There are times when there are so many loud signals crammed into the RTTY sub-band that the receiver just can't handle it. I've 
personally experienced this on many occasions. In these cases, I've had to either had to use the AIP function in my receiver or put in 
some attenuation. Don't be guilty of making false accusations to someone you think is sending out spurious signals. If you don't know 
for sure, it's best not to say anything over the air. If you're convinced someone is sending out a poor quality signal, be nice in your 
approach and be helpful in trying to identify the problem with the other station. It may be better to wait until after the contest and send 
that person a private E-mail telling them you believe they might have a problem with their signal.

So make sure your signal is clean and make sure you know what you are talking about if you are going to tell someone else they have a 
poor quality signal.

Being on the Right Frequency

One of the biggest complaints after every RTTY contest is that many stations still call off frequency. There are two main reasons for 
this - AFC and NET. With the popularity of sound card programs, comes the problem of not operating the software correctly and 
forgetting to turn AFC and NET functions off when necessary. These seven rules may help:

1. Use AFC only when CQ'ing. Turn it OFF when S&P (Search & Pounce).
2. Use NET when S&P only. Turn it OFF when CQ'ing.
3. Until you become comfortable with AFC and NET functions (NET is only used with AFSK transmission), it's better to keep both 
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OFF at all times and tune with your receiver's RIT.
4. If you tune with your receiver's RIT, make sure you reset it to zero or turn it off after use.
5. Tune in the station you want to call as closely as you can before transmitting.
6. Do not vary your transmit frequency when calling CQ'ing.
7. Never use XIT in RTTY.

Using a Carriage Return to Start your Buffer Message

It is common practice and a good idea to start each important buffer message that you transmit with a Carriage Return (CR). Why? So 
the information you transmit is viewed on a new line on the receiving station's screen. Without the leading CR, the start of your 
message could come on the tail end of random noise characters and may look like this:

XMORPA5PZE690Z1ZT 599 001 LA BK

What you see here could easily happen if you don't begin your message with a CR. Unless a receiving station is using a RTTY 
demodulator with a squelch circuit, random characters will scroll across the screen when no signal is detected. This is normal. Noise 
looks like a signal to the RTTY demodulator. It may take the RTTY demodulator a character or two to synchronize with an actual 
incoming signal. On strong to moderate signals, most RTTY demodulators are good enough to synchronize very quickly if it sees a CR. 
In actuality, a CR is the CR baudot "character" plus a Line Feed (LF) "character", then a LTRS or FIGS "character". CR, LF, LTRS 
and FIGS characters are all non-printing characters. The CR returns the cursor to the far left hand side of the screen and the LF 
advances the cursor to the next line. All this is sent before your text goes out. That is at least 3 baudot characters which are sent before 
the first text character of your message. This gives the RTTY demodulator on the other end plenty of time to synchronize with your 
signal. Most RTTY programs today will always advance the LF when it sees a CR, therefore you should never see a line print over an 
existing line.

I realize this may be a little difficult for a beginner to understand, just consider putting a CR at the beginning of each important buffer 
message as a courtesy to the receiving station. Try not to make him decipher your message when it's adjoined with noise characters. In 
the example above, I'm sending a report to W1ZT without a CR at the beginning of my Exchange message. George is an excellent 
RTTY operator and would easily know the report is for him but had I put the CR at the start of the buffer message it would have come 
out like this:

XMORPA5PZE (noise)
W1ZT 599 001 LA BK

A carriage return is %R in WriteLog RTTY message buffers.

Ending your Buffer Messages

Do you need a CR at the end of your message?

I say no. You should end your message with K, BK, KN or a SPACE to separate the end of the message from noise characters. It's OK 
if you see:

W1ZT 599 001 LA BKERMEPXIBOPELSEA

The receiving station does not absolutely need to see the K, BK or KN clearly at the end of the transmission. By listening to the receive 
signal, the receive station knows the transmission has ended. Putting a CR at the end of a transmission actually could cause a problem 
with RTTY programs that move each line up when a CR is received. If the receiving station is clicking on information in his receiving 
window and a CR is received, the line moves up and he then has to chase the information up the screen. This does not happen with 
programs like WriteLog that keep each line in the same place on the screen at all times.

Answering CQ Stations

When you answer a station that is sending CQ, you should observe some simple rules. The main, #1 rule is to NEVER call with a 
report first. Always wait until the CQ station comes back to you first. You only need to send your callsign. There is really no need to 
send the CQ'ing station's callsign. He or she already knows his/her callsign. If he/she calls CQ, then he/she should know that the station 
calling is for him/her. Many send the CQ station's call once before they send their own and it's acceptable. If you are going to begin our 
call message with the other station's callsign, send it once and only once. But it's not necessary.
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Let's say I am calling CQ.

CQ CONTEST DE AA5AU AA5AU CQ K

To answer you should send the following:

DE W1ABC W1ABC W1ABC K

Sending your callsign 3 times is the norm. Sending your callsign twice is OK. There are times when you might send your call only once 
or when you might send it more than 3 times. And you should ALWAYS send DE before your callsign. Why? Because in most RTTY 
contest programs, the DE triggers some sort of database which highlights your callsign on the other station's screen making it easier for 
the receiving station to pick up your call when it follows DE. This is important. You want your callsign highlighting on the receiving 
station's screen.

Work All Dupes

With the advent of Cabrillo scoring, it's important that when you make a two-way contact in a contest that the QSO is logged on both 
station's computer. If someone calls you that you have logged previously in a contest and it's a "dupe" according to your log, you need 
to work him again to make sure you are in his log. If you aren't in his log, then your QSO will not count. So work all dupes. It's much 
faster to work the station and log him again than it is to argue about it. It only takes a few seconds and you won't be penalized for it. 
Never send a "WKD B4" message.

Be Considerate

Be considerate of others over the air. Remember, this is just a sport, a hobby. Try to contain your emotions if someone upsets you. 
Don't air your dirty laundry over the air. Wait until after the contest and vent your frustration in your 3830 post or a message to the 
RTTY Reflector. Arguing with someone over the air is just a waste of time. If someone really upsets you with the way they act on the 
air, send them an E-mail after the contest.

If you find you have accidentally made a mistake, a quick "Sorry" works very well over the air. People make mistakes. You will make 
mistakes, I will make mistakes and everyone else will make mistakes.

Be considerate of other modes. Don't deliberately cause interference to other stations just because they are using a different digital 
mode, CW or SSB. There's not much you can do when someone deliberately interferes with you but to move away from them. Don't try 
to fight back, you are only wasting time.

Always remember that you are contesting for fun.

If you follow the suggestions above you will have fun. And that's why we contest.

73 & Good RTTY Contest!, Don AA5AU
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